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Predgovor 

Odabir teme završnog rada nastao je prilikom  upisivanja kolegija 3D modeliranje gdje sam se 

upoznao sa svijetom i mogućnostima izrade virtualnih modela i likova. Budući da sam i prije toga 

bio zaljubljenik u znanstvenu fantastiku i virtualne modele, obrazovanje mi je omogućilo 

realiziranje stvaranja modela postajući dio ljudi koji vole prikazati svoju kreativnost u tom 

području. Izradom praktičnog dijela rada nastojao sam prikazati proces kreiranja virtualnih likova 

koristeći znanje iz savladanih programa te pritom dodatno napredovati i usavršiti stečeno znanje. 

 

U ovom dijelu htio bih zahvaliti mentoru Doc.dr.sc. Andriji Berniku na strpljenju i motivaciji 

tijekom školovanja i izrade rada, a posebno velika zahvalnost obitelji i prijateljima koji su bili uz 

mene. 

 



 

 

Sažetak 

3D modeliranje je proces stvaranja i izrade objekta ili modela unutar 3D prostora. Modeli u 3D 

prostoru obično su izrađeni od poligonalnih objekta koji se sastoje od vrhova, linija i lica. Za izradu 

virtualnih likova koriste se različiti programi ovisno za što će se model koristiti. 

Vodeći program u toj industriji je Autodesk Maya radi svog širokog seta značajki i raznih 

mogućnosti modeliranja, teksturiranja, osvjetljenja i renderiranja. U ovom radu biti će objašnjeno 

korisničko sučelje programa Maya, metode modeliranja, poligonalno i NURBS modeliranje, kao 

i izbornici s alatima za njihovu izradu i manipuliranje za dobivanje željenih površina. Nastavno na 

metode modeliranja objašnjena je pravilna izrada topologije i ostale tehnike modeliranja, izrada 

materijala, kreiranje UV točaka, kao i izrada teksturnih mapa. 

Objašnjen je program Substance Painter radi izrađenih tekstura u njemu. Radi potrebe 

praktičnog dijela rada obuhvaćen je teorijski dio koji se koristi prilikom renderiranja i izrade 

svjetla. U dijelu praktičnog rada prikazan je tijek pripreme za kreiranje modela, tijek izrade modela 

kroz obje metode modeliranja, tijek izrade tekstura unutar različitih programa, kao i završno 

poziranje modela radi daljnjeg korištenja. Za potrebe prikaza izrađenog modela renderirane su 

slike modela u namještenoj pozi. 

 

Ključne riječi: 3D, 2D, Autodesk Maya, modeliranje, poligon, NURBS, UV, teksture 

 

  



 

 

Summary 

 

3D modeling is the process of creating an object or model within a 3D space. Models in 3D 

space are usually made of polygonal objects consisting of vertices, lines, and faces. Different 

programs are used to create virtual characters depending on the purpose of the model. 

The industry's leading program is Autodesk Maya known for its wide range of features and a 

variety of modeling, texturing, lighting and rendering abilitys. This academic paper explaines the 

user interface of the Maya program, modeling methods, polygonal and NURBS modeling, as well 

as tool menus for their creation and manipulation for obtaining needed surfaces. Furtermore, in 

addition to the modeling methods, the correct design of the topology and other modeling 

techniques, the production of materials, the creation of UV points, as well as the production of 

texture maps are explained. 

The Substance Painter program is explained because of the textures created in it. For the 

purpose of the practical part of the paper, the theoretical part used in rendering and making light 

is included. In the practical part of the paper, the proces of preparation for creating a model, the 

proces of creating a model through both modeling methods, the proces of creating textures within 

different programs, as well as the final posing of the model for further use are explained. For the 

purpose of displaying the created model, the images of the model in the set position were rendered. 

 

Keywords: 3D, 2D, Autodesk Maya, modeling, polygon, NURBS, UV, texture 



 

 

Popis korištenih kratica 

3D   Three-dimensional  

Trodimenzionalno  

2D   Two-dimensional  

Dvodimenzionalno 

CAD   Computer Aided Design 

Oblikovanje s pomoću računala 

NURBS  Non-Uniformal Rational Bezier Splines 

  Neujednačene racionalne Bezierove krivulje 

CV  Control Vertex 

  Kontrolni vrhovi 

PBR   Physically Based Rendering 

  Fizički točan računalni prikaz 

 

 

  



 

 

Sadržaj  

1. UVOD ...................................................................................................................................................................... 1 

2. 3D MODELIRANJE ................................................................................................................................................. 2 

3. AUTODESK MAYA ................................................................................................................................................ 3 

3.1. KORISNIČKO SUČELJE MAYE ............................................................................................................................. 3 

3.2. MODELIRANJE .................................................................................................................................................. 5 

3.2.1. Poligoni ................................................................................................................................................ 5 

3.2.2. NURBS ................................................................................................................................................ 6 

3.2.3. Subdivizijsko modeliranje ..................................................................................................................... 7 

3.3. OSNOVE POLIGONA I NURBS-A ......................................................................................................................... 7 

3.3.1. Razlike između poligona i NURBS-a ..................................................................................................... 8 

3.3.2. Kreiranje modela ................................................................................................................................... 8 

4. ALATI KOD POLIGONALNOG MODELIRANJA................................................................................................. 10 

4.1. EXTRUDE ....................................................................................................................................................... 10 

4.2. COMBINE, SEPARATE I EXTRACT ...................................................................................................................... 11 

4.3. BOOLEANS ..................................................................................................................................................... 12 

4.4. SCULPT GEOMETRY TOOL ............................................................................................................................... 12 

4.5. MIRROR GEOMETRY ....................................................................................................................................... 13 

4.6. BRIDGE.......................................................................................................................................................... 13 

4.7. INTERACTIVE SPLIT TOOL ............................................................................................................................... 14 

4.8. INSERT EDGE LOOP TOOL................................................................................................................................ 14 

4.9. OFFSET EDGE LOOP TOOL ............................................................................................................................... 15 

4.10. DUPLICATE FACE ....................................................................................................................................... 15 

4.11. ALATI ZA SPAJANJE .................................................................................................................................... 15 

4.12. BEVEL ...................................................................................................................................................... 16 

4.13. CREASE TOOL ........................................................................................................................................... 16 

5. TOPOLOGIJA I RETOPOLOGIJA ......................................................................................................................... 17 

6. ALATI KOD NURBS MODELIRANJA .................................................................................................................. 19 

6.1. KRIVULJE ...................................................................................................................................................... 19 

6.1.1. Izrada krivulja koristeći primarne oblike .............................................................................................. 20 

6.1.2. CV Curve Tool .................................................................................................................................... 21 

6.1.3. EP Curve Tool .................................................................................................................................... 21 

6.1.4. Bezier Curve Tool ............................................................................................................................... 22 

6.1.5. Arc Tools ............................................................................................................................................ 22 

6.2. IZBORNIK EDIT CURVES .................................................................................................................................. 23 

6.3. IZBORNIK SURFACES ....................................................................................................................................... 24 

6.3.1. Revolve .............................................................................................................................................. 24 

6.3.2. Loft .................................................................................................................................................... 25 

6.3.3. Planar ................................................................................................................................................. 25 

6.3.4. Extrude ............................................................................................................................................... 26 

6.3.5. Square................................................................................................................................................. 26 

6.4. IZBORNIK EDIT NURBS .................................................................................................................................. 27 

7. OSTALE TEHNIKE MODELIRANJA .................................................................................................................... 28 



 

 

7.1. DIGITALNO KIPARSTVO ................................................................................................................................... 28 

7.2. CAD MODELIRANJE ........................................................................................................................................ 29 

7.3. PROCEDURALNO MODELIRANJE ........................................................................................................................ 30 

7.4. 3D SKENIRANJE .............................................................................................................................................. 30 

8. SJENČANJE ........................................................................................................................................................... 31 

8.1. MATERIJALI ................................................................................................................................................... 31 

8.2. HYPERSHADE ................................................................................................................................................. 32 

9. UV TOČKE ............................................................................................................................................................ 34 

9.1. UV MAPIRANJE .............................................................................................................................................. 34 

9.1.1. Kreiranje UV mapa ............................................................................................................................. 34 

9.2. UV TEXTURE EDITOR ..................................................................................................................................... 37 

9.2.1. Izvoz UV setova .................................................................................................................................. 38 

10. TEKSTURNE MAPE ......................................................................................................................................... 39 

10.1. MAPA BOJE (MAPA TEKSTURE) ................................................................................................................... 39 

10.2. MAPE ZA IZMJENU GEOMETRIJE................................................................................................................... 39 

10.2.1. Bump map .......................................................................................................................................... 40 

10.2.2. Normal map ........................................................................................................................................ 40 

10.2.3. Displacement map ............................................................................................................................... 41 

10.3. SPECULAR MAP.......................................................................................................................................... 41 

11. SUBSTANCE PAINTER ................................................................................................................................... 42 

11.1. KORISNIČKO SUČELJE ................................................................................................................................ 42 

12. RENDERIRANJE I OSVJETLJENJE ................................................................................................................. 44 

12.1. MAYA SOFTWARE ..................................................................................................................................... 44 

12.2. MENTAL RAY ............................................................................................................................................ 44 

12.3. OSVJETLJENJE ........................................................................................................................................... 44 

13. PRAKTIČNI DIO .............................................................................................................................................. 46 

13.1. MODELIRANJE ........................................................................................................................................... 46 

13.1.1. Izrada referentne slike ......................................................................................................................... 47 

13.1.2. Modeliranje poligonima ....................................................................................................................... 47 

13.1.3. NURBS modeliranje ............................................................................................................................ 53 

13.2. DODAVANJE MATERIJALA ........................................................................................................................... 56 

13.3. IZRADA UV MAPA ..................................................................................................................................... 57 

13.4. IZRADA TEKSTURA U SUBSTANCE PAINTERU................................................................................................. 58 

13.5. IZRADA TEKSURA U MAYI .......................................................................................................................... 60 

13.6. IZRADA TEKSTURE U PHOTOSHOPU .............................................................................................................. 61 

13.7. POZIRANJE MODELA ................................................................................................................................... 61 

13.8. RENDERIRANJE MODELA ............................................................................................................................ 64 

14. ZAKLJUČAK .................................................................................................................................................... 67 

  



1 

 

1. Uvod 

Kreiranje virtualnih likova nastaje unutar programa koji se koriste za izradu 3D modela. Svrha 

izrade završnog rada je prikazati tijek izrade modela kroz proces modeliranja, dodavanja 

materijala, kreiranja UV mapa, izradu tekstura i pripremu za korištenje nakon kreiranja modela. 

3D modeliranje je proces u kojem se izradom objekta i njegovom  manipulacijom kroz razne 

alate unutar virtualnog 3D prostora izrađuje oblikovana površina. Takav proces modeliranja 

najčešće koristi izradu modela putem poligona ili krivulja.  

U ovom radu objašnjen je program za modeliranje te je unutar poglavlja programa Autodesk 

Maya objašnjena metoda izrade modela putem poligonalnog i NURBS modeliranja. Također su u 

tom dijelu rada definirane razlike u izgledu geometrije kao i način kreiranja modela, zašto se 

koriste različite metode modeliranja te gdje se primjenjuju. Prikazani su svi primarni oblici te koje 

su razlike između opcija za kreiranje.  

Kroz slikovne primjere korištenja teorijski su objašnjeni svi alati za modeliranje kao i svi 

potrebni izbornici za realizaciju istog. Kako je prilikom modeliranja važno imati pravilan izgled  

površine geometrije obuhvaćena je tema topologije sa nabrojanim prednostima i načinom  

popravka površine. 

Kako 3D modeliranje obuhvaća široko područje primjene nabrojane su i ostale tehnike 

modeliranja i za što se sve primjenjuju. Sjenčanje je proces u kojem se izgled površine definira 

prema tome kako je zasjenjena. Dodavanjem materijala započinje proces teksturiranja gdje se 

unutar atributa materijala mogu namještati razni atributi poput boje, prozirnosti i sjaja. Definiranje 

izgleda površine unutar programa Maya omogućeno je primjenom čvorova materijala na objekt. 

Oni definiraju kako će površina reagirati na svjetlost.  

Svaki objekt koji je izgrađen u 3D prostoru ima i svoje UV točke koje predstavljaju koordinate 

te površine dvodimenzionalno. Maya prema zadanim postavkama kreira UV točke za sve primarne 

oblike, ali prilikom uređivanja modela potrebno je namještanje UV točaka u prostoru. Postupak 

stvaranja UV-a za površinsku mrežu naziva se UV mapiranje. U ovom dijelu rada objašnjeno je 

kako se kreiraju UV mape i u kojem izborniku se pristupa uređivanju izrađenih mapa.  

Nakon izrade materijala i njihovog dodavanja na površine modela te izrade UV mapa započinje 

izrada tekstura. U ovom dijelu objašnjene su vrste teksturnih mapa koje se koriste prilikom procesa 

teksturiranja. Objašnjen je program Substance Painer i njegovo sučelje jer sam prilikom izrade 

praktičnog dijela rada različite teksturne mape izrađivao u njemu.  

Po završetku teksturiranja model je bilo potrebno pripremiti za daljnji tijek rada, a za 

prikazivanje modela u praktičnom dijelu rada model sam namjestio u željenu pozu i izradio 

nekoliko renderiranih slika. 
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2. 3D modeliranje 

3D modeliranje je proces stvaranja 3D prikaza bilo koje površine ili objekta manipulacijom 

poligona, rubova i vrhova u simuliranom 3D prostoru. Rezultati 3D modeliranja mogu se vidjeti u 

filmovima, animacijama i video igrama. 3D modeliranje postiže se ručno uz specijalizirani softver 

za 3D proizvodnju koji umjetniku omogućuje stvaranje i deformiranje poligonalnih površina ili 

skeniranjem objekata iz stvarnog svijeta u skup podataka s kojima se digitalno predstavljaju 

objekti. 3D modeliranje koristi se u širokom rasponu polja, uključujući inženjering, arhitekturu, 

zabavu, film, specijalne efekte, razvoj igara i komercijalno oglašavanje. [1]  

3D softver vrsta je računalnog grafičkog softvera koji omogućuje dizajn, razvoj i proizvodnju 

trodimenzionalne grafike i animacije. 3D softver omogućava korisnicima da u trodimenzionalnom 

području vizualiziraju, dizajniraju i upravljaju objektom, okolinom ili bilo kojim grafičkim 

elementom. 3D softver uključuje programe računalnog dizajna CAD (eng. Computer Aided 

Design)  i animacijske pakete. [2] 

 Na tržištu postoje brojni softverski programi za 3D modeliranje, a najkorišteniji su:  

Maya: izvrsna u modeliranju, teksturiranju, osvjetljavanju i renderiranju - njen široki set 

značajki uključuje čestice, kosu, fiziku čvrstog tijela, tkanine, simulacije tekućine i animaciju 

likova. 

Houdini: široko upotrijebljen u VFX industriji za stvaranje niza 3D slika, Houdinijev nodalni 

proceduralni pristup pruža digitalnim umjetnicima neviđenu razinu snage, fleksibilnosti i kontrole, 

te  uz to ima i tradicionalnije alate za izravno komuniciranje s poligonima na ekranu. 

Cinema 4D: program za parametrijsko modeliranje Cinema 4D općenito je vrlo dobar, a može 

se dodati još više funkcionalnosti nizom cjenovno pristupačnih dodataka i koristi se u svijetu 

grafike pokreta, vizualizacije i ilustracije. 

3ds Max: 3D računalni grafički program za računala koji se koristi za proizvodnju televizijskih 

i igranih filmova te za arhitektonsku i vizualizacijsku proizvodnju. Ima vrlo robustan set alata za 

3D modeliranje, simulacije tekućina, kose i krzna, izradu kostura i animaciju likova. Mogu se 

koristiti i izravne tehnike manipulacije i proceduralno modeliranje. 

Blender: besplatan program  za modeliranje, teksturiranje, animaciju i renderiranje. Program 

je otvorenog koda, postoji već duže vrijeme, ima vrlo impresivan set alata za modeliranje i 

oblikovanje 3D modela. Smatra se potpuno održivom alternativom plaćenim programima 

modeliranja. 

ZBrush i Mudbox: samostalni programi za oblikovanje i modeliranje koji su najprikladniji za 

stvaranje organskih oblika i osim digitalnog kiparstva može se koristiti za izradu UV mapa i 

slikanje tekstura. [3] 
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3. Autodesk Maya 

Autodesk Maya je 3D računalni grafički softver, a uobičajeno poznata kao Maya softver. 

Koristi se za stvaranje realističnih 3D modela, 3D aplikacija, animiranih filmova, TV serija, 

reklama, 3D video igara, vizualnih efekata i mnogih drugih efekata. Prije upotrebe naprednih alata 

poput Autodesk Maya korišten je tradicionalni način animacije, tj. 2D animacija. U današnje 

vrijeme većina filmske industrije koristi Autodesk Mayu za pružanje visoke kvalitete u 3D 

animacijama. Ovih dana Autodesk Maya aktivno se koristi u filmskoj industriji, industriji 

videoigara, nekretninama, automobilskoj industriji i mnogim drugim industrijama za stvaranje 

realističnih 3D i vizualnih efekata. [4] 

3.1. Korisničko sučelje Maye 

Prilikom otvaranja programa Maya odmah ispod naslovne trake programa nalaze se elementi 

korisničkog sučelja: Traka glavnog izbornika (eng. Menu bar), Statusna linija (eng. Status bar) i 

Polica (eng. Shelves). U sredini sučelja nalazi se radni prostor koji prema zadanim postavkama 

prikazuje pogled iz perspektive. Sa desne strane nalaze se Urednik atributa (eng. Attribute Editor) 

i Okvir kanala ( eng. Channel Box), a na lijevoj strani nalaze se Alatni okvir (eng. Toolbox) i 

Konfiguracija prikaza prozora (eng. Window configuration) . U donjem dijelu sučelja nalaze se 

Kontrola vremenske trake i reprodukcije (eng. Timeline and Playback Controls), Vremenski 

raspon ( eng. Time Range), Komandni redak ( eng. Command Line) i Urednik skripti (eng. Script 

Editor). 

 

Slika 3.1 Početno sučelje Maye 
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Navigacija unutar programa Maya odvija se pomoću tipke Alt. Da bi se okretala kamera koristi 

se Alt + lijeva tipka miša, kako bi se zumiralo koristi se Alt + desna tipka miša i kako bi se pratila 

kamera koristi se Alt + srednja tipka miša. Zumirati se može također okretanjem kotačića miša. U 

perspektivnom prikazu mogu se koristiti sve tri vrste pokreta, dok je u ortografskim prikazima 

(odozgo, bočno i prednje) ograničen samo na praćenje i zumiranje. [7] 

 

Slika 3.2 Navigacija 

Traka izbornika pojavljuje se na vrhu sučelja Maye, neposredno ispod naslovne trake Maye, i 

prikazuje odabrani skup izbornika. Svakom skupu izbornika odgovara modul unutar Maye: 

Animacija (eng. Animation), Poligoni (eng. Polygons), Površine (eng. Surfaces), Renderiranje 

(eng. Rendering) i Dinamika (eng. Dynamics). Moduli su metoda za grupiranje povezanih značajki 

i alata. Između skupova izbornika prebacuje se odabirom odgovarajućeg modula iz padajućeg 

izbornika u statusnoj traci. Prilikom prebacivanja između modula izbornika, desna se skupina 

izbornika mijenja, ali lijevi dio ostaje isti. Lijevi izbornici uobičajeni su izbornici za sve skupove 

izbornika i njih je 7: Datoteka, Uredi, Izmijeni, Stvori, Zaslon, Prozor i Sredstva. 

Statusna traka, smještena izravno ispod Trake izbornika, sadrži razne stavke od kojih se većina 

koristi za modeliranje ili rad s objektima unutar Maye. Alatna traka sadrži ikone koje omogućuju 

prebacivanje između različitih alata za manipuliranje, a najvažniji su Pomicanje, Skaliranje i 

Rotiranje.  

Okvir kanala i Urednik atributa prvenstveno se koriste za podešavanje parametara geometrije, 

s time da se unutar Urednika atributa pokazuje još više svojstava, uključujući vrste materijala 

objekta. Urednik slojeva podsjeća na Photoshopov ili Illustrarov Urednik slojeva kod kojeg se 

mogu stvoriti novi slojevi, izbrisati slojevi, preimenovati slojevi i uključiti te isključiti svojstva 

sloja. Maya ima nekoliko različitih vrsta slojeva od kojih se najviše koriste slojevi zaslona i slojevi. 

[5], [6], [7] 
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Slika 3.3 Urednik atributa i okvir kanala 

3.2. Modeliranje 

U programu Maya izrada modela može biti izvedena na 3 načina, putem poligona, koristeći 

krivulje (NURBS) ili subdivizijsko, što je hibrid navedenih dvaju načina, ali se u novijem vremenu 

sve manje koristi. Razlika između poligonalnog i NURBS modeliranja je način na koji računalo 

računa geometriju. 

3.2.1. Poligoni 

Poligoni su površine sastavljene od lica (eng. Face), a svako lice je ograđeno od rubova (eng. 

Edge), bilo da su to tri ruba, četiri ruba ili više (n-gon). Te površine se mogu sastojati od mnogo 

lica, koliko ih vaše računalo može obraditi ili samo od jednog lica. Svaki rub prolazi pravocrtno i 

točka na kojoj se te crte spajaju naziva se vrh (eng. Vertex). Budući da su rubovi poligona ravne 

linije, oni lako stvaraju tvrde površine za koje je potrebno više lica da bi se stvorile glatke, 

zakrivljene površine, prilikom čega se povećava razlučivost modela, tj. broj poligona. Ovisno o 

hardverskim specifikacijama postoji prag broja poligona koji određeno računalo može podnijeti. 

Poligonalni modeli mogu se kombinirati i spajati, rezati, oblikovati, ekstrudirati, izvlačiti, 

preslikavati UV itd. [8]  

Trostrani i četverostrani poligoni najčešći su elementi poligonalnog modeliranja. Grupa 

poligona povezanih zajedničkim rubnim točkama nazivaju se model (eng. Mesh). 
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Ovisno o području za koje se modeli rade, potrebno je obratiti pozornost na geometriju modela 

isto kao i na razne deformacije nastale uslijed modeliranja. Najčešće pogreške su dvije ili više 

rubnih točaka s istim koordinatnim vrijednostima i preklapanje poligona. Unutar programa za 

modeliranje ovi problemi nisu posebno naglašeni i program neće reagirati na pogrešku čim je 

korisnik napravi. Rezultat toga mogu biti veliki problemi jednom kada se takav model primjenjuje 

u vojnim ili civilnim simulacijama u stvarnom vremenu ili kod visoko kvalitetnih laserskih ispisa 

gdje je vidljivo i najmanje odstupanje. Kako bi se pogreške minimizirale, korisnik koji stvara 3D 

model trebao bi jako dobro poznavati alat koji koristi i područje primjene modela. [9] 

 

 

Slika 3.4 Elementi poligonalnog modeliranja 

3.2.2. NURBS 

NURBS (Non-Uniformal Rational Bezier Splines) je matematički izraz koji 3D modele 

prikazuje pomoću krivulja i površina. Rezultat je glatka površina bez nazubljenosti rubova 

neovisno o veličini monitora ili rezoluciji. Geometrija NURBS-a bazira se na Bézierovoj 

krivulji koju program automatski iscrtava između kontrolnih vrhova (eng. Control Vertex, 

CV). Svaka krivulja ima početak, kraj i zakrivljenost. Stupanj zakrivljenosti ovisi o kontrolnim 

vrhovima unutar krivulje. Dodavanjem vrhova u krivulju, dobivaju se nove točke za 

manipulaciju, pri čemu se ne narušava glatkoća niti zaobljenost. Površina NURBS-a definirana 

je krivuljom koja se naziva isoparma (eng. Isoparme).  Isoparma je krivulja koja nastaje 

upotrebom CV-a. Površina stvorena između isoparmi sastoji se od spanova (eng. Spans) koji 

prate zakrivljenost površine definiranu isoparmima. [9] 
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3.2.3. Subdivizijsko modeliranje 

Subdivizijsko modeliranje površina predstavlja kombinaciju NURBS-a i poligona. 

Modeliranje najčešće počinje kao poligonalno, a zatim se koristi matematika NURBS-a kako bi se 

zagladili grubi rubovi modela. Subdivizijske površine su definirane rekurzivno. Proces počinje 

dobivenim poligonalnim mrežama koje se usavršavaju te se ponovno primjenjuju stvarajući nova 

lica i vrhove na 3D modelu. Proces podjele se teoretski može izvoditi u beskonačnost, ali u praksi 

je primjena ovoga algoritma ograničena. Sheme prerade subdivizijske površine mogu se uglavnom 

podijeliti u dvije kategorije: interpoliranje i aproksimiranje. Interpolacijske sheme moraju 

odgovarati izvornom položaju vrhova u izvornoj mreži. Aproksimirajuće sheme ne moraju, one će 

prilagođavati pozicije prema potrebi. U pravilu, aproksimirajuće sheme imaju veću glatkoću, ali 

zahtijevaju veću optimizaciju koraka. Način rada subdivizijskih površina ovisi o vrsti poligona na 

kojem se radi. Neke funkcije primjenjive su samo na četverostranim poligonima, dok druge rade 

samo na trokutima. [9] 

 

3.3. Osnove poligona i NURBS-a 

Prilikom modeliranja potrebno je koristiti različite metode modeliranja, ovisno o potrebama i 

svrsi modela. U programu Maya najčešće se koriste metode modeliranja poligona i NURBS-a. 

Prilikom odabira postupka važna je odluka koju metodu koristiti kako bi se postigao dizajn modela. 

Iako je čest slučaj korištenje obiju metoda u kasnijem procesu NURBS modele možemo pretvoriti 

u poligone. Modeliranje poligonima najzastupljenije je iz razloga što se završni model izrađuje iz 

jednog geometrijskog modela s mnogo lica. Modeli izrađeni na takav način mogu se deformirati 

bez straha od „pucanja“ modela, što zna biti slučaj kod NURBS-a. Poligonalni modeli su 

najjednostavniji za prikaz na računalu, koriste se u video igrama, gdje trebaju prikazati modele 

dok se igra izvodi. U industriji igara modelari kreiraju modele s malim brojem poligona (eng. low 

poly models), koje računalo ili igraća konzola može prikazati u stvarnom vremenu. Modeli 

poligona veće rezolucije (eng. high poly models) koriste se u televizijskoj i filmskoj industriji. 

Budući da složeniji modeli poligona mogu biti izrađeni od jednog modela ili mreže koriste se za 

animaciju likova. Modeli u animaciji likova dosta se savijaju i iskrivljuju, stoga je korisno da 

kompleksni modeli nisu odvojeni na šavovima kako ne bi pucali. [10] 
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3.3.1. Razlike između poligona i NURBS-a 

Glavna razlika između poligonalnog i NURBS modeliranja je način na koji računalo računa 

mrežu, tj. površinu modela. Kod modeliranja poligona računalo izračunava poligone, koji su ravne 

plohe koje sadrže 3D oblik, kao što je na primjer kocka. NURBS izračunava mrežu kao spojeve 

između točaka, što može napraviti krivulje iz jednog dijela geometrije. Koristeći složenu 

matematiku za izračunavanje površine modela, taj način prikladniji je za modele gdje je potreban 

visok stupanj preciznosti. Loša strana matematičkog izračuna veličine modela je što računalu 

postaje teže izračunati, te nije prikladno za programe u kojima vrijeme prikazivanja mora biti brzo. 

To je jedan od razloga zašto se NURBS modeli ne koriste u video igrama. U poligonalnom 

modeliranju nije moguće napraviti savršeno glatku krivulju, jer se uvijek izračunavaju kao ravna 

crta između točaka. Međutim, korištenjem zaglađivanja grupa i velikog broja poligona moguće je 

izraditi dijelove koji se na zaslonu doživljavaju kao glatka krivulja. Prednost korištenja NURBS-

a je manja veličina datoteke gdje su svi sadržani podaci matematičke točke, stoga je te podatke 

lako čitati i razumjeti između različitih programa i nikada se neće dobiti oštećene mreže kao što 

se može dogoditi prilikom prijenosa poligonalnih modela. 

Iako korištenje NURBS modela ima prednosti, njihov nedostatak je što su svi modeli 

četverostrani, dok je kod poligonalnih modela obično N-gon koji se sastoji od bilo kojeg broja 

stranica, gdje je najmanji trokut. To čini postupak modeliranja poligona mnogo jednostavnijim 

postupkom i model je lakše manipulirati i mijenjati, te to olakšava izgradnju mreže. NURBS 

modeli su uvijek odvojeni jedni od drugih što ih čini teškim za spojiti u jedan model. Zbog njihovih 

savršenih izračuna zakrivljenosti i položaja, šavovi između njih se ne vide, ali to je još uvijek 

ograničenje u njihovom tijeku rada jer ako se žele animirati potrebno ih je pretvoriti u poligonalnu 

mrežu kako bi se mogli „zavariti“ spojevi i kako se ne bi razdvojili. Ako se radi o modelu kojem 

je potrebna tekstura, bolje je koristiti poligon mrežu jer se na taj način ima mogućnost prilagodbe 

kako se tekstura projicira na mrežu, dok kod NURBS modela mrežu nije moguće prilagoditi.[11] 

3.3.2. Kreiranje modela 

Primarni oblici su najjednostavniji modeli koji se mogu izraditi u Mayi ili nekom drugom 3D 

programu. To su jednostavni geometrijski oblici, a mogu se izraditi od poligona ili NURBS-a, te 

im se može definirati razina detalja površine. Izradom primarnog oblika može se definirati razina 

podjela koja definira broj vrhova i lica.  
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Slika 3.5 Primarni oblici 

Razlika između opcija za kreiranje NURBS-a ili poligona je u mogućnostima detalja površine. 

Detalji na NURBS površini definirani su pomoću isoparmi i spanova, a kod poligonalne površine 

detalji su definirani licima koja su podijeljena na određen broj redaka i stupaca. Osim primarnih 

oblika, poligonalne površine mogu se izraditi pomoću krivulja koje se koriste za izradu NURBS 

površina, pretvaranjem cijele NURBS površine u poligone i korištenjem alata Create Poyligon 

Tool, kojim se može direktno u 3d prostoru postavljati vrhove i stvarati poligonalno lice. [10] 

Slika 3.6 Primjer kreiranja teksta alatom Create>Text 
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4. Alati kod poligonalnog modeliranja 

Prije samog početka modeliranja, unutar Statusne trake potrebno je odabrati modul Poligoni 

kako bi se desni dio izbornika promijenio u skup izbornika za poligone. Prebacivati između modula 

može se na dva načina: odabirom unutar padajućeg izbornika ili pritiskom tipke F3. Najvažniji 

alati koji su potrebni za modeliranje poligona nalaze se u izbornicima Mreža (eng. Mesh) i Uredi 

Mrežu (eng. Edit Mesh). Objašnjeni su samo najvažniji alati potrebni za izradu rada koristeći Maya 

korisnički vodič i program Maya 2014. 

 

Slika 4.1 Izbornici Mesh i Edit Mesh 

4.1. Extrude 

Alat Extrude najčešće je korišteni alat za uređivanje poligona, koristi se za izvlačenje lica, 

rubova ili točaka, ovisno što smo odabrali i time se dodaju nove površine. Prilikom izvlačenja 

površine na novonastalim licima moguće je dodati podjelu i promijeniti ofset, a na izvučenom 

dijelu moguće je mijenjati veličinu, kut i smjer pomoću manipulatora. Još jedan način korištenja 

alata Extrude je izvlačenje lica po krivulji. Da bi se pratila krivulja na novonastalim licima 

potrebno je dodati potreban broj podjela i cijeli izvučeni dio može se uviti i suziti. Također 

micanjem kvačice sa Edit Mesh>Keep Faces Together, prilikom odabira više lica ili rubova svaki 

dio izvlači se zasebno. Slika 4.2. prikazuje sve načine korištenja alata Extrude. 
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Slika 4.2 Primjer korištenja alata Extrude 

4.2. Combine, Separate i Extract 

Koristeći Mesh>Combine dva ili više različita modela mogu se kombinirati u jedan pri čemu 

se topologija mreža ne mijenja. Taj alat koristi se prije korištenja različitih operacija uređivanja 

poligona kao što je spajanje rubova ili točaka različitih modela. 

Alat Mesh>Separate razdvaja poligonalne mreže u svoje zasebne mreže ili dio odabranih lica 

u zasebnu mrežu, što znači da je to obrnuta radnja od Combine. 

Pomoću alata Mesh>Extract označeni dio lica s poligonalne mreže može se odvojiti i stvaraju 

se dodatni rubovi prilikom čega se mreža može odvojiti ili može ostati dio postojeće mreže. Slika 

4.3. prikazuje kombiniranu mrežu kugle i kocke koristeći Combine pri čemu je gornji dio kugle 

odvojen koristeći Extract.  

 

Slika 4.3 Primjer korištenja alata Combine i Extract 
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4.3. Booleans  

Postoje 3 logičke operacije prilikom korištenja Mesh>Booleans za kombiniranje modela, a to 

su Union, Difference i Intersection. Modeli se mogu spajati, oduzimati ili presijecati kako bi se 

izradio složeniji model. 

 

Slika 4.4 Primjer korištenja alata Booleans 

4.4. Sculpt Geometry Tool 

Ovaj alat ima 7 operacija u sebi, a to su: Push, Pull, Smooth, Relax, Pinch, Slide, Erase. Alat 

za skulpturnu geometriju omogućuje ručno oblikovanje mreže potezom kista po površini koji gura 

ili povlači vrhove. Moguće je namjestiti radijus kista za širinu i dubinu. Korištenje ovog alata 

slično je oblikovanju gline i radi na istom principu kao i alati u programima za digitalno kiparstvo. 

 

Slika 4.5 Sculpt Geometry Tool 
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4.5. Mirror Geometry 

Mesh>Mirror Geometry je alat koji omogućuje stvaranje duplikata odabranog poligona 

preslikanog preko neke od 3 osi. Maya po zadanim postavkama model zrcali po osi +X i spaja ga 

sa originalom, a sve to možemo mijenjati u postavkama.  

 

Slika 4.6 Primjer korištenja Mirror Geometry alata po osima 

4.6. Bridge 

Edit Mesh>Bridge alat koristi se za spajanje lica ili rubnih linija na jednoj mreži, ako je radnju 

potrebno izvršiti na dva različita modela potrebno ih je prvo kombinirati. U postavkama može se 

odrediti broj podjela na putanji i da li će mreža koja spaja rubove ili lica biti linearna putanja, 

glatka putanja ili glatka putanja + krivulja.  

 

Slika 4.7 Bridge alat korišten na licu i na rubovima 
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4.7. Interactive Split Tool 

Ovaj alat vrlo je jednostavan za korištenje, sa njime se dijeli jedno ili više lica na mreži 

poligona u više lica nakon što se odredi mjesto sjecišta. 

 

 Slika 4.8 Primjer korištenja alata Interactive Split Tool 

4.8. Insert Edge Loop Tool 

Edit Mesh>Insert Edge Loop Tool je alat koji se koristi za umetanje jedne ili više rubnih petlji 

preko cijelog ili djelomičnog rubnog prstena na poligonalnoj mreži. Koristi se prilikom dodavanja 

detalja na većem području mreže. U postavkama može se odrediti udaljenost od rubova koja može 

biti relativna, jednaka ili će biti podijeljeno na jednak broj polja. Držanjem tipke Shift prilikom 

postavljanja petlje ona će poštovati tok zakrivljenosti okolne mreže. 

 

Slika 4.9 Primjer korištenja alata Insert Edge Loop Tool sa različitim postavkama 

 

Slika 4.10 Primjer korištenja alata Insert Edge Loop Tool + edge flow 
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4.9. Offset Edge Loop Tool 

Ovaj alat sličan je prethodnom, razlika je u tome što se sa svake strane prstena ubacuje jedna 

linija koja može biti relativno ili jednako udaljena od ruba. 

 

Slika 4.11 Primjer korištenja alata Offset Edge Loop Tool 

4.10. Duplicate face 

Edit Mesh>Duplicate Face alat je koji omogućava dupliciranje bilo kojeg lica na mreži i to lice 

postaje dijelom izvorne mreže modela.  

 

Slika 4.12 Primjer korištenja alata Duplicate Face 

4.11. Alati za spajanje 

U ovu skupinu alata spadaju: Merge, Merge To Center, Collapse, Merge Vertex Tool, Merge 

Edge Tool, Delete Edge/Vertex. Zajedničko je svima što spajaju lica, rubove ili vrhove sa 

različitim postavkama i mogućnostima. 



16 

 

4.12. Bevel  

Ovim alatom stvaraju se zakošeni poligoni na odabranim rubovima, a moguće je namještati 

neke parametre. Dobru primjenu ima u zaglađivanju rubova. 

 

Slika 4.13 Primjer korištenja alata Bevel 

4.13. Crease Tool 

Edit Mesh>Crease Tool je alat koji se koristi na rubnim dijelovima poligonalnog modela gdje 

se želi postići tvrd rub ili prijelaz bez dodavanja nove geometrije. Slika 4.13. prikazuje glatki 

prikaz modela bez obrade, sa korištenjem alata Crease Tool i sa dodatnom geometrijom.  

 

Slika 4.14 Primjer razlike u broju lica modela 
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5. Topologija i retopologija  

Prilikom modeliranja važno je imati pravilnu topologiju jer uvelike olakšava rad s modelom. 

Topologija je organizacija, protok i struktura vrhova, rubova i lica 3D modela. Održavanje 

dobre topologije ima brojne prednosti:  

− Lakši rad s modelima - model se može lako izmijeniti ako ima dobru topologiju u 

usporedbi s modelom s lošom, neurednom topologijom gdje se vrhovi nasumično 

postavljeni bez razloga 

− Deformirane animacije su fluidne – kada su vrhovi organizirani na način koji ima 

smisla s obzirom na to kako se modeli savijaju i deformiraju, animacija postaje lakša i 

glatkog izgleda, na taj način izbjegava se stvaranje artefakata poput probijanja i čudnih 

mjestimičnih istezanja 

− Koristi manje memorije – model s lošom topologijom i previše vrhova, rubova i lica 

zauzima više memorijskog prostora, dobra topologija osigurava stvaranje 3D modela 

koristeći najmanju potrebnu količinu vrhova [13] 

 

Slika 5.1 Primjer loše i dobre topologije [13] 

Retopologija je postupak uzimanja modela s lošom topologijom i izrade kopije tog modela s 

dobrom topologijom, što bi značilo da je to postupak popravljanja modela s lošom topologijom. 

Ona se koristi kao dodatak ostalim tehnikama modeliranja kod kojih je topologija u drugom planu. 

Proces retopologizacije uglavnom uključuje tehniku poligonalnog modeliranja.  
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Korištenje retopologije u tijeku rada obuhvaća:  

− Stvaranje modela pomoću digitalnog kiparstva ili 3D skeniranja gdje je rezultat dobar 

model s lošom, prenatrpanom, neurednom i neorganiziranom topologijom 

− Korištenje dobivenog detaljnog modela s lošom topologijom kao osnovu, povrh koje 

se stvara nova mreža koja koristi poligonalno modeliranje da bi se retopologizirala nad 

visoko detaljnim modelom (unutar Maya programa koristi se Alat Quad Draw) 

− Rezultat je nešto manje detaljan model, ali gotovo jednako precizan u odnosu na izvorni 

model 

− Modelar može koristiti alat Transfer Maps, koji se nalazi unutar modula Renderiranje i  

Izbornika Lighting/Shading, kako bi sačuvao detalje iz izvornog modela i primijenio 

dobivene  mape tekstura na retopologiziranu verziju niže rezolucije. [13] 

 

Slika 5.2 Primjer retolologije  [13] 

 

Slika 5.3 Primjer retopologije koristeći alat Quad Draw u Mayi 
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6. Alati kod NURBS modeliranja 

 

Kod modeliranja pomoću NURBS-a, unutar Statusne trake potrebno je odabrati modul 

Površine kako bi se desni dio izbornika promijenio u skup izbornika za NURBS-e. Prebacivati 

između modula može se na dva načina: odabirom unutar padajućeg izbornika ili pritiskom tipke 

F4. Najvažniji alati koji su potrebni za modeliranje NURBS-ima nalaze se u izbornicima Stvori 

(eng. Create), Uredi Krivulje (eng. Edit Curves), Površine (eng. Surfaces) i Uredi NURBS-e (eng. 

Edit NURBS). Objašnjeni su samo najvažniji alati potrebni za izradu rada koristeći Maya 

korisnički vodič i program Maya 2014. 

 

 Slika 6.1 Edit Curves, Surfaces i Edit NURBS 

Koristeći NURBS metodu modeli se mogu izraditi iz primarnih oblika koji se mogu 

modificirati, mogu se odsjeći dijelovi primarnih oblika i izradom NURBS krivulja koje definiraju 

geometriju modela. Tijek rada definiran je ovisno o  potrebama i izgledu modela.  

6.1. Krivulje  

Krivulje su sastavni dio kod izrade modela NURBS metodom. One se mogu izraditi iz 

primarnih oblika ili crtanjem u 3D prostoru. Unutar izbornika Stvori postoji nekoliko alata za 

izradu krivulja: CV Curve Tool, EP Curve Tool, Bezier Curve Tool, Pencil Curve Tool i Atc tools.  
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6.1.1. Izrada krivulja koristeći primarne oblike 

Izradom primarnog oblika kruga, unutar Urednika Atributa ili Okvira kanala mogu se definirati 

parametri radijusa, zamaha kruga, stupnja zakrivljenosti koji može biti kubični ili linearni i broj 

odjeljka, a kod kvadrata mogu se definirati duljine stranica, stupanj zakrivljenosti i broj spanova 

po stranici.  

 

Slika 6.2 Primjer izrade kruga i kvadrata 

Slika 6.3. prikazuje dodavanje krivulja koristeći konstrukcijskih isoparma i točaka bilo gdje na 

površini. Nakon odabira isoparma ili točke za izradu krivulja korišten je alat Insert Isoparms.  

 

Slika 6.3 Primjer dodavanja krivulja 
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6.1.2. CV Curve Tool 

Odabirom Create>CV Curve Tool izrađuje se krivulja gdje prvi CV ima oblik kvadrata, drugi 

CV ima oblik slova U i program Maya izrađuje trupove (eng. Hulls) između postavljenih CV-ova. 

Za svaki CV postavljen nakon trećeg crta se krivulja, a kako bi se obrisao zadnji CV koristi se 

tipka Delete. Pritiskom tipke Insert ulazimo u način uređivanja i pojavljuje se manipulator na 

zadnjem CV-u. U načinu uređivanja segmenti krivulje mogu se micati ili obrisati, te ponovnim 

pritiskom tipke Insert se vraća na dodavanje CV-a. Tipkom Enter završava se izrada krivulje. 

 

Slika 6.4 Primjer izrade krivulje alatom CV Curve Tool 

6.1.3. EP Curve Tool 

Odabirom Create>EP Curve Tool izrađuje se krivulja crtanjem točaka krivulje u prostoru. Za 

svaku točku postavljenu nakon prve Maya crta oblik krivulje. Pritiskom tipki Delete, Insert i Enter 

dobivaju se iste mogućnosti kao što su opisane u korištenju alata CV Curve Tool. 

 

Slika 6.5 Primjer izrade krivulje alatom EP Curve Tool 
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6.1.4. Bezier Curve Tool 

Odabirom Create>Bezier Curve Tool izrađuje se krivulja u prostoru. Kako bi se postavilo 

sidrište potrebno je kliknuti bilo gdje u prostoru, a kako bi se postavilo sidrište sa manipulatorima 

potrebno je kliknuti i povući miš u prostoru. Za dodavanje sidrišta bilo gdje na krivulji potrebno 

je kliknuti na željeno mjesto na krivulji, te kako bi obrisali sidrište potrebno je kliknuti na njega i 

pritisnuti tipku Delete. Da bi se krivulja zatvorila potrebno je držati tipke Control i Shift, te 

pritisnuti na zadnje sidrište. Odabirom bilo kojeg sidrišta na krivulji i držeći pritisnutu tipku 

Control te povlačenjem u prostor, tom sidrištu se dodaju manipulatori. Tipkom Enter se završava 

izrada krivulje, a selektiranjem izrađene krivulje i pritiskom na alat moguće je ponovno uređivanje 

izrađene krivulje.  

 

Slika 6.6 Primjer izrade krivulje alatom Bezier Curve Tool 

6.1.5. Arc Tools 

Ovaj alat ima dvije mogućnosti, izradu luka sa dvije ili tri kontrolne točke. Kod kreiranja luka 

sa dvije točke, postavlja se prva, a zatim i druga točka na željeno mjesto u prostoru, te se pokazuju 

manipulatori za luk. Kod kreiranja luka s tri točke, postavlja se prva točka, točka na krivulji te 

krajnja točka, gdje se sve tri točke mogu namještati u prostoru. Unutar opcija moguće je namjestiti 

broj sekcija krivulja. 
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Slika 6.7 Primjer izrade krivulje alatom Arc Tool 

 

6.2. Izbornik Edit Curves 

Izbornik Edit Curves sadrži razne alate za modifikaciju krivulja, a najznačajniji su: 

- Duplicate Surface Curves - stvara novu krivulju od 

odabrane površinske točke, izoparme ili krivulje na 

površini 

- Attach Curves - spaja NURBS krivulje na krajnjim 

točkama kako bi se stvorila nova krivulja 

- Detach Curves - dijeli krivulju na dvije nove krivulje 

- Align Curves - poravnava krajnje točke dviju krivulja 

- Open/Close Curves -  pretvara krivulju iz otvorene u 

zatvorenu i obrnuto 

- Move Seam - premješta točku spajanja krivulje na 

odabranu točku 

- Cut Curve – dijeli krivulje na mjestu presijecanja 

- Intersect Curves – stvara lokatore na presjeku krivulja 

- Curve Fillet – stvara krivulju između dvije krivulje koje 

se ne sijeku 

- Insert Knot – ubacuje točku uređivanja na mjestu 

odabrane točke krivulje 

Slika 6.8 Izbornik Edit Curves 
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- Extend – produžuje krivulju za jednu točku 

- Offset – stvara kopiju krivulje odmaknutu od originalne krivulje 

- Reverse Curve Direction – okreće smjer odabrane krivulje 

- Rebuild Curve – izvodi razne operacije za izmjenu krivulje  

- Smooth Curve – zaglađuje odabranu krivulju 

 

6.3. Izbornik Surfaces 

U ovom izborniku postoji nekoliko alata za izradu NURBS površina  pomoću krivulja. 

Površine koje su stvorene iz krivulja mogu mijenjati oblik manipulacijom krivulja od kojih su 

izgrađene, što je dobro ako je nakon korištenja alata za izradu površine potrebno dodatno 

namještanje površine. Kako bi se to izbjeglo potrebno je označiti izgrađeni model i obrisati mu 

povijest. 

 

Slika 6.9 Izbornik Surfaces 

6.3.1. Revolve 

Alat Revolve najčešće se koristi  sa NURBS krivuljama, omogućuje stvaranje novog modela 

na temelju okretanja oko određene osi. U opcijama ovog alata, osim odabira osi mogu se podesiti 

stupanj zakrivljenosti koji može biti linearni ili kubični, početni i završni stupanj zamaha, broj 

segmenata i izlazna geometrija.   
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Slika 6.10 Primjer korištenja alata Revolve 

6.3.2. Loft  

Alat Loft koristi se sa dvije ili više krivulja, te između njih stvara površinu. U opcijama alata 

moguće je namjestiti stupanj zakrivljenosti koji može biti linearni ili kubični, broj spanova, raspon 

krivulje i izlazna geometrija.  

 

Slika 6.11 Primjer korištenja alata Loft 

6.3.3. Planar 

Alat Planar  izrađuje ravnu površinu unutar jedne ili više graničnih krivulja.  

 

Slika 6.12 Primjer korištenja alata Planar 
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6.3.4. Extrude 

Alat Extrude izrađuje površinu profilne krivulje po putanji odabrane krivulje, a unutar opcija 

alata može se namjestiti stil, završna pozicija, putanja, orijentacija, rotacija, skaliranje, dužina 

krivulje i izlazna geometrija. 

 

Slika 6.13 Primjer korištenja alata Extrude 

6.3.5. Square 

Alat Square izrađuje četverostranu površinu ispunjavanjem područja definiranog s četiri 

granične krivulje koje se sijeku.  

 

Slika 6.14 Primjer korištenja alata Square 
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6.4. Izbornik Edit NURBS 

Izbornik Edit NURBS sadrži razne alate za modifikaciju površina, a najznačajniji su: 

− Duplicate NURBS Patches – duplicira odabranu površinu 

− Project Curve on Surface – stvara krivulju na površini projekcijom krivulje na površinu 

− Intersect Surfaces – stvara krivulje na površini gdje se dvije površine sijeku 

− Trim Tool – skriva dijelove površine definirane krivuljama na površini 

− Booleans > Union Tool, Difference Tool, Intersection Tool – izrezuje dvije površine 

korištenjem logičkih operacija spajanja, oduzimanja ili presijecanja 

− Attach Surfaces – spaja dvije površine u jednu 

− Detach Surfaces – dijeli površinu u više površina na selektiranim isoparmima 

− Align Surfaces – poravnava dvije površine i stvara kontinuitet tim površinama 

− Open/Close Surfaces – pretvara površinu između otvorene i zatvorene 

− Move Seam – premješta šav zatvorene površine na odabranu izoparmu 

− Insert Isoparms – stvara izoparmu na površini ili 

između odabranih izoparma 

− Extend Surfaces – izdužuje površinu na odabranom 

isoparmu 

− Rebuild Surfaces – izvodi razne operacije na odabranoj 

površini 

− Round Tool – stvara zaobljene prijelazne površine na 

rubovima 

− Stitch> Stitch Surface Points, Stitch Edges Tool, 

Global Stitch – skupina alata za spajanje površina 

− Sculpt Geometry Tool – omogućuje ručno oblikovanje 

površine potezom kista 

 

 

 

 

 

 

Slika 6.15 Izbornik Edit NURBS 
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7. Ostale tehnike modeliranja 

Uz tehnike modeliranja poligonima i NURBS-ima postoje i ostale tehnike koje se primjenjuju 

u izradi 3D modela, ovisno o potrebama i zahtjevima te načinu primjene modela. Te tehnike 

obuhvaćaju digitalno kiparstvo, CAD modeliranje, proceduralno modeliranje i 3D skeniranje.  

7.1. Digitalno kiparstvo 

Pojavom digitalnog doba i kiparstvo se vrši na ekranu računala putem specijaliziranog softvera. 

3D digitalno kiparstvo odnosi se na postupak dizajniranja 3D modela od strane umjetnika na platnu 

koje nudi napredni softver. Digitalna skulptura razvijena je na osnovnom modelu odmah od 

početka paletom tekstura i oblika koji nalikuju stvarnim glinenim i stjenovitim skladbama. 

Osnovni model je poliran i pročišćen kistovima raznim softverskim alatima koji omogućuju 

dotjerivanje i oblikovanje modela na željeni način. Izgled modela izrađuje se pomoću poligonalnih 

mreža koje se stvaraju pomoću složenih matematičkih izračuna u pozadini. Dizajn započinje 

grubom modifikacijom mreže i postupno se dotjeruje oblik uz više detalja kroz povećanje broja 

poligona. Razni alati dostupni u softveru omogućuju izmjenu i manipulaciju geometrijskog modela 

ili oblika. Potiskivanje, povlačenje i deformacija geometrijskih obilježja uzrokuju oblikovanje 

skulpture. Također se može umetnuti dodatna geometrija koja odgovara skulptorskim potrebama. 

Povećanje broja poligona zahtjeva veliku procesorsku snagu, više radne memorije i napredne 

grafičke mehanizme. Svaka podjela povećava potražnju za računalnim resursima i usporava 

izvedbu projekta, te je u fazi izrade modela važno na pravilan način povećavati izgled i broj 

poligona modela. Poznatiji programi specijalizirani za izradu modela tehnikom digitalnog 

kiparstva su Mudbox, ZBrush i Sculptris. [14] 

 

Slika 7.1 Tijek rada tehnikom digitalnog kiparstva [15] 
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7.2. CAD modeliranje 

Kratica CAD (eng. Computer Aided Design) predstavlja dizajn uz pomoć računala. Pokriva 

širok spektar alata za dizajn, a koristi se u industrijama poput arhitekture, dizajnu igrica, 

umjetnosti, proizvodnji i inženjerstvu. CAD sustavi pomažu svojim korisnicima izvodeći tisuće 

složenih geometrijskih izračuna u pozadini, što posao dizajnera čini lakšim.  

Početak CAD modeliranja započeo je ograničavanjem na samo 2D mogućnosti, objekti su se 

mogli dizajnirati i crtati koristeći osnovne poglede: gore, dolje, lijevo, desno, sprijeda, straga i 

pogled pod kutom koji se naziva  još izometrijski pogled. U osnovi je djelovalo poput crtanja 

nečega u 2D-u na papiru gdje je složena matematika urađena umjesto korisnika.  

Slijedom toga razvili su se 3D CAD programi koji su omogućili korisniku da izradi 2D prikaze 

i „izvuče“ ih sa površine u 3D objekt prikazan na zaslonu. U osnovi mogu se stvoriti neograničeni 

složeni oblici svih veličina i izgleda. Gotovo svaki moderni proizvod je stvoren pomoću 3D CAD 

modeliranja. 

Koristeći ovu metodu modeliranja u osnovi se stvaraju objekti virtualne stvarnosti koji mogu 

imati ista svojstva kao i stvarni fizički objekti, poput materijala, težine, veličine, optičkih i fizičkih 

svojstva itd. To omogućuje stvaranje virtualnog modela, te mogućnost testiranja i provjere kako 

će se taj model ponašati u stvarnom svijetu. [16] 

Neki od poznatijih programa za 3D CAD modeliranje su Fusion 360, Solidworks, AutoCAD, 

Rhino i CATIA.  

 

Slika 7.2 Primjer složenog  3D CAD oblika izrađenog u programu SolidWorks [16] 
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7.3. Proceduralno modeliranje 

Proceduralno modeliranje odnosi se na dizajne koji se generiraju algoritamski, a koje umjetnik 

ne izrađuje ručno. Ovdje se objekti i scene razvijaju na temelju korisničkih parametara ili pravila. 

U različitim paketima za modeliranje okoliša, modelatori mogu stvoriti čitave krajolike mijenjajući 

parametre poput raspona nadmorske visine ili gustoće lišća, također može se  birati između 

krajolika poput obalnih područja, pustinje ili planina. Za razvoj 3D dizajna koriste se razne tehnike 

modeliranja za igre. 

Proceduralno modeliranje opsežno se koristi u organskim objektima poput lišća i drveća, gdje 

su složenost i varijacije beskonačne. Ove je modele izuzetno teško crtati rukom. Ti se objekti mogu 

dalje podesiti kroz razne postavke koje se mogu uređivati. [17] 

U programu Maya unutar modula Renderiranje za kreiranje proceduralnih modela koristi se 

izbornik  Paint Effects>Get Brush prilikom čega se otvara prozor Visor. Unutar Visora u kartici 

Paint Effects može se odabrati jedan od kistova koji su raspoređeni u nekoliko kategorija kao što 

su oblaci, električni, vlakna, vatra, trave, drveće itd.  Kako bi se Paint Effects-i renderirali 

korištenjem priključka (eng. Plug-in) Mental Ray potrebno ih je pretvoriti u poligonalnu ili 

NURBS geometriju.  

 

Slika 7.3 Primjer korištenja Paint Effects-a 

7.4. 3D skeniranje  

3D skeniranje metoda je digitalizacije predmeta iz stvarnog svijeta kada je potrebna 

nevjerojatno visoka razina foto realizma. Objekt iz stvarnog svijeta skenira se, analizira i sirovi 

podaci (obično x, y, z oblak točaka) koriste se za stvaranje točne poligonalne ili NURBS 

mreže.[18] 

Kako je već navedeno u radu za ovu tehniku modeliranja potrebno je napraviti retopologiju 

modela ako se model želi koristiti u animaciji i slično.  



31 

 

8. Sjenčanje 

U stvarnom svijetu dva glavna čimbenika određuju izgled površine, a to su svjetlost i od čega 

je materijal napravljen. Kad svjetlost pogodi objekt, dio svjetlosti se apsorbira, a dio odbije. Što je 

objekt glađi, to je sjajniji, te što je grublji je više mat. U programu Maya izgled površine definira 

se prema tome kako je zasjenjena. Površinsko sjenčanje kombinacija je osnovnog materijala 

modela i svih tekstura koje su na njega primijenjene. 

Materijali, nazivani još i shaderi (eng. Shaders) definiraju supstancu modela. Najosnovniji 

atributi materijala su boja, prozirnost i sjaj. Čimbenici izvan osnovne boje, prozirnosti i sjaja koji 

određuju izgled površine objekta, poput složenije boje, prozirnosti, sjaja, reljefa površine, 

refleksije ili atmosfere, definirani su teksturama. [19] 

8.1. Materijali 

Iako 3D površine u programu Maya reagiraju na svjetlost slično onima u stvarnom svijetu, 

postoje značajne razlike u načinu interakcije površina i svjetla u softveru za računalnu grafiku. 

Čvorovi materijala (eng. Material Nodes), kada se primjenjuju na objekt, omogućuju definiranje 

izgleda površine objekta kada se generira. 

U Maya-i čvorovi materijala definiraju kako površine reagiraju na svjetlost. Maya sadrži 

nekoliko vrsta čvorova materijala koji pomažu simulirati stvarne kvalitete ili ponašanje površina 

na svjetlost, a to su: čvorovi površinskog materijala, čvorovi volumetrijskog materijala i čvor 

materijala izbočina. Mogu se postaviti atributi materijala, kao što su boja, zrcalnost, refleksija, 

prozirnost i površinski detalji elemenata scene kako biste stvorili širok spektar realističnih slika. 

Prilikom stvaranja objekta, Maya prema zadanim postavkama dodjeljuje posebnu verziju 

materijala Lambert1 što je površinski materijal. Površinski materijal predstavlja vrste površina na 

koje se može mapirati teksture, materijal izbočina omogućuje da se pomoću slike odredi reljef 

površine objekta, a volumetrijski materijal prikazuje fizički izgled pojava iz prirode kao što je 

magla, dim, prašina i druge fine čestice. [20] 

 

Dodavanjem materijala započinje proces teksturiranja modela, a osnovni tipovi materijala u 

programu Maya su: 

Lambert – mat materijal bez sjaja. Osnovni tip materijala koji se po osnovnim postavkama 

nalazi na svakom modelu. 
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Blinn – reflektirajući, sjajni materijal, najskuplji je materijal za renderiranje. Sjaj na materijalu 

se može prilagođavati prema potrebi, te se može postaviti na modelu bez prijelaza ili s oštrim 

prijelazom sjaja na reflektirajući dio materijala. Doživljava se kao metal ili ogledalo. 

Anisotropic – materijal s postepenim prijelazom boja kao što se može vidjeti na CD-u, peru ili 

na tkaninama satena i svile. Polukružni prijelazi se mogu orijentirati i rasporediti na različite 

načine, postavlja se refleksija i oštrina prijelaza.  

Phong – stakleni, sjajni materijal s oštrim osvjetljenjem. Primjenjuje se na modelima 

automobila, staklenim predmetima. Prema potrebi se kontrolira oštrina i jasnoća refleksije i 

osvjetljenja.  

Ramp – materijal kojim se kontroliraju prijelazi između više boja i tekstura. Ima mogućnost 

dodavanja neograničenog broja prijelaza i boja. Teksture se također mogu dodati na materijal i 

mogu se miješati s bojama. Omogućuje i ostale opcije kao što je refleksija, transparentnost, i 

sjajnost. [21] 

Koristeći priključke možemo imati pristup Mental Ray i Substance materijalima. 

 

Slika 8.1 Hypershade 

8.2. Hypershade 

Hypershade je prozor u kojem se mogu stvoriti, urediti i povezati čvorovi za prikazivanje, kao 

što su teksture, materijali, svjetla, programi za renderiranje i posebni efekti. Hypershade prikazuje 

svaki čvor kao ikonu koja predstavlja karakteristike čvorova. Kada se uređuju atributi čvora ili 

dodjeljuje tekstura ili specijalni efekt, čvor se ažurira kako bi vizualno prikazao te promjene.  



33 

 

Za otvaranje Hypershade-a unutar programa potrebno je odabrati izbornik Window>Rendering 

Editors>Hypershade. [22] 

Hypershade jedan je od glavnih prozora prilikom sjenčanja i teksturairanja modela. Izgled 

proza podijeljen je na tri dijela, a to su: lijevi dio za kreiranje, desni dio u kojem su unutar više 

kartica raspoređeni materijali, teksture, kamere, svjetla te ostale kartice i u donjem dijelu se nalazi 

radni prostor. 

 

 

Slika 8.2 Izgled mreže čvorova unutar radnog prostora Hypershade-a 
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9. UV točke 

UV točke su dvodimenzionalne koordinate teksture koje sadrže informacije o komponentama 

vrhova za poligonalne i subdivizijske površine. UV točke su bitne jer osiguravaju vezu između 

površinske mreže i načina na koji se tekstura slike preslikava na površinsku mrežu. Teksture 

primijenjene na poligone ili subdivizijske površine koje nemaju koordinate UV teksture neće se 

prikazati. Iako program Maya prema zadanim postavkama kreira UV-ove za sve primarne oblike, 

nakon uređivanja modela biti će potrebno preurediti UV-ove. Zadani raspored obično neće 

odgovarati naknadnom uređivanju modela, jer se mjesto koordinata UV teksture ne ažurira 

automatski prilikom uređivanja površina mreža. 

U većini slučajeva nakon što se dovrši modeliranje UV-i se mapiraju i uređuju, i slijedom toga 

se dodaju teksture. U suprotnom promjenom na modelu stvorit će se neusklađenost između modela 

i UV-a i to će utjecati kako će se teksture pojaviti na modelu. Za NURBS površine koordinate UV-

a koje kontroliraju postavljanje teksture postoje prema zadanim postavkama i implicitno su 

povezane s kontrolnim vrhovima, te kako se oni premjeste tako se mijenjaju i položaji 

odgovarajućih koordinata UV teksture. [23] 

9.1. UV mapiranje 

Postupak stvaranja UV-a za površinsku mrežu naziva se UV mapiranje.  Tim postupkom se 

stvaraju, uređuju i na druge načine raspoređuju UV točke koje se pojavljuju kao ravni 

dvodimenzionalni prikaz površinske mreže iznad dvodimenzionalne slike koja se koristi kao 

tekstura kakva se i prikazuje u Uredniku UV teksture ( eng. UV Texture Editor).  [23] 

9.1.1. Kreiranje UV mapa 

Kako bi se kreirale UV mape potreban je izbornik Create UVs, 

koji se nalazi u modulu Poligoni. Unutar izbornika postoji 

nekoliko alata za  mapiranje UV-a: Planar Mapping, Cylindrical 

Mapping, Spherical Mapping, Automatic Mapping i Create UVs 

Based On Camrera, kao i alat za kreiranje praznog UV seta.  

 

.  

 

Slika 9.1 Izbornik Create UVs 
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Planar Mapping projicira UV na mrežu kroz ravnu plohu. Ova projekcija je najbolja za objekte 

koji su relativno ravni ili su kompletno vidljivi samo iz jednog kuta. Moguće je označiti samo 

nekoliko elemenata i izraditi projekciju na samo određene elemente modela. Ova projekcija kod 

kompleksnijih modela stvara preklapanje UV mreže jer ne stvara više komada UV mreža, već su 

sve UV točke spojene u jednu mrežu. Planarno mapiranje može izraditi zajedničke preklapajuće 

UV točke koje mogu izgledati kao teksturne granice. Da bi se jasno vidjele teksturne granice, može 

se uključiti opcija Texture Borders Edge. Zajedničke preklapajuće UV točke mogu izazvati 

vidljive rubove granica, pa nastaje problem ako se koriste alati i opcije za 3D Paint. Da bi se to 

izbjeglo, ručno se odvajaju UV točke opcijom Edit Uvs – Layout. Planarno mapiranje funkcionira 

pravilno na jednom modelu istodobno, a ako se treba projekcija primijeniti na više poligonalnih 

objekata u jednom koraku, alatom Combine se grupiraju objekti u jedan objekt, primjenjuje se 

projekcija, te se naknadno prema potrebi objekti mogu razdvojiti. U suprotnom, projekcija se 

koristi na svakom modelu posebno. [24] 

 

Slika 9.2 Primjer planarnog mapiranja 

Cylindrical Mapping izrađuje UV točke za objekte bazirane na cilindričnoj projekciji i mreža 

se omotava oko objekta. Ova projekcija je najbolja za objekte koji su kompletno zatvoreni i 

okruglog su, cilindričnog oblika. Kod složenijih oblika dolazi do preklapanja UV točaka, a mreža 

se sastoji od samo jednog komada. [24] 

 

Slika 9.3 Primjer cilindričnog mapiranja 
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Spherical Mapping izrađuje UV mrežu korištenjem projekcije koja je bazirana na kuglastom 

omotu oko modela. Ova projekcija je najbolja za oblike koji mogu biti cijeli zatvoreni i vidljivi u 

sklopu okruglog objekta, bez projiciranja praznih ili nepravilnih dijelova. [24] 

 

Slika 9.4 Primjer sfernog mapiranja 

Automatic Mapping izrađuje poligonalnu UV mrežu pokušavajući naći najbolji UV položaj 

projiciran iz više pogleda. Automatsko mapiranje je specificiranje broja panela koji će biti 

korišteni za UV projekciju i koristi se kod pravilnih i nepravilnih oblika modela. Kod automatskog 

mapiranja projicira se s tri strane modela, te se stvara više UV mreža koje se naknadno spajaju u 

cjelinu, rotiraju i prilagođavaju teksturi. Ova metoda UV mapiranja je korisna na kompleksnijim 

oblicima gdje planarna, cilindrična ili sferna  projekcija ne izrađuje UV točke koje su korisne. [24] 

 

Slika 9.5 Primjer automatskog mapiranja 

Create UV's Based On Camera izrađuje UV teksturne koordinate za označeni objekt putem 

trenutačnog pogleda kamere. Pogled kamere postaje ploha projekcije na objekt, a funkcionira na 

principu planarnog mapiranja. [24] 
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9.2. UV Texture Editor 

Koristeći izbornik Edit UVs>UV Texture Editor pristupa se Uredniku UV tekstura koji 

omogućuje pregled i korištenje raznih alata za uređivanje  i namještanje koordinata UV-a. Radi 

lakšeg tijeka rada sa UV točkama unutar Konfiguracije prikaza prozora radne površine moguće je 

namjestiti istodobni prikaz  Urednika UV Tekstura i prikaza iz perspektive. 

 

Slika 9.6 Primjer prikaza modela unutar Urednika UV Tekstura 

Urednik UV teksture omogućuje pregled i interaktivno uređivanje koordinata UV teksture za 

poligon, NURBS i subdivizijske površine u 2D prikazu. Unutar njega može se odabrati, pomicati, 

skalirati i općenito mijenjati UV topologija za površinu slično kao što se radi s drugim alatima za 

modeliranje unutar programa Maya. Isto tako unutar Urednika UV Tekstura može se prikazati 

slika povezana s dodijeljenom mapom tekstura kao pozadina i može se izmijeniti raspored UV-a 

kako bi se po potrebi podudarao. [25] 

 

Slika 9.7 Primjer namještanja UV-a prema povezanoj slici 
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9.2.1. Izvoz UV setova 

Unutar prozora Urednika UV Tekstura koristeći izbornik Image>Create PSD Network moguće 

je izvesti UV set odabranog modela u program Photoshop kako bi se izradila tekstura prema snimci 

UV-a (eng. UV snapshoot), pri čemu je moguće namještanje postavke slike, UV-a  i odabir atributa 

materijala.  

 

Slika 9.8 Primjer izvoza UV seta 
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10. Teksturne mape 

U vizualnoj umjetnosti tekstura je bilo koja površinska pojedinost. U programu Maya 

površinski detalji se stvaraju teksturama povezanim s materijalom modela kao mape tekstura. 

Materijali definiraju osnovnu supstancu modela, a teksture dodaju detalje. Teksture se mogu 

povezati s gotovo bilo kojim atributom materijala, od kojih su najčešći boja, prozirnost i sjaj 

(spekularnost). Mogu se dodati detalji izgledu površine modela dodavanjem površinskog reljefa 

povezivanjem tekstura u mape za izmjenu geometrije. Set 2D i 3D tekstura dostupan je u programu 

Maya, gdje se osim tih tekstura može postaviti tekstura datoteke koja povezuje teksturu s vlastitom 

slikovnom datotekom. 

Također se može ispeći osvjetljenje i boja na teksturi što se kasnije može primijeniti na modele 

u sceni. [26] 

10.1. Mapa boje (Mapa teksture) 

Mapa boje je upravo ono što i sam naziv implicira, to je tekstura koja mijenja osnovnu boju, 

tj. boju površine što može biti boja, 2D tekstura, 3D tekstura ili slikovna datoteka koja se unutar 

Urednika atributa  mijenja pod uobičajenim atributima materijala odabirom boje. 

 

 

Slika 10.1 Primjer Mape boje sa povezanom slikovnom datotekom 

10.2. Mape za izmjenu geometrije 

Ove mape imaju mogućnost izmjene finih detalja geometrije modela. Uglavnom se koriste kod 

modela visoke rezolucije mreže i primjenjuju se na mrežu niske rezolucije kako bi lažirali detalje 

mreže visoke rezolucije. Postoje 3 vrste ovih mapa, a to su: Mapa izbočina (eng. Bump map), 

Mapa udubina (eng. Displacement map) i Mapa normala, tj. Detaljna mapa (eng. Normal map).  
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10.2.1. Bump map 

Mapa izbočina  je najosnovniji oblik mapa koje mijenjaju geometriju, one najmanje zahtijevaju 

resurse jer koriste jednostavan algoritam za promjenu izgleda modela. Mape izbočina koriste sivu 

ljestvicu tekstura, gdje crna boja označava najniži dio lažne geometrije, a bijela najviši i siva koja 

je negdje između ovisno o nijansi. [27]  

Slika 10.2. prikazuje poligonalni model niže rezolucije bez Mape izbočine i sa njom, a izgled 

mape definiran je mrežom crne boje sa bijelom pozadinom.  

 

Slika 10.2 Primjer korištenja Mape izbočina 

10.2.2. Normal map 

Detaljno mapiranje djeluje zamjenom interpolirane normalne površine onom koja se 

procjenjuje iz RGB teksture, pri čemu svaki kanal (crveni, zeleni, plavi) odgovara koordinatama 

X, Y i Z površinske normale. [28] 

 

Slika 10.3 Primjer detaljne mape 
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Detaljna mapa izvrsno funkcionira u većini scenarija jer odlično odrađuje lažne detalje na 

ravnim površinama, zakrivljenim površinama i oko rubova, ali njezin najveći nedostatak je što ne 

mijenja geometriju. Korištenje Detaljnih mapa izvrsno je za igre gdje se prednost daje učinku 

izvođenja , a ne kvaliteti. [27]  

10.2.3. Displacement map 

Mapa udubina još je jedan korak više od Detaljnih mapa, ali ujedno koristi najviše resursa zbog 

činjenice, za razliku od Mape izbočina i Detaljne mape, ona mijenja geometriju. Kao i Mapa 

izbočina koristi vrijednosti sive ljestvice teksture. Zbog činjenice da Mapa udubina zapravo stvara 

dodatnu geometriju ima najbolje rezultate, te daje malo naznaka izvornog oblika mreža s niskim 

brojem poligona. Ova dodatna izvedba ograničava njezinu upotrebu, te se obično koristi za 

renderiranje slika i filmove. [27] 

 

10.3.  Specular map 

Spekularna mapa ( eng. Specular maps) mapa je koja se koristi za definiranje sjaja površine i 

isticanje boje. Što je vrijednost piksela veća, to će površina biti sjajnija. Također koristi sivu 

ljestvicu tekstura. Koristi se boja piksela za izračunavanje rezultirajuće boje površine. Vrlo 

zasićena Spekularna mapa imat će jako različit vizualni efekt od sive Spekularne mape. [29] 

 

Slika 10.4 Primjer Spekularne mape  
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11. Substance painter 

Allegorithmic’s Substance Painter nevjerojatno je moćan alat za 3D oslikavanje. Može se 

usporediti s 3D verzijom Adobeovog Photoshopa za digitalno slikanje. Glavna svrha programa 

Substance Painter je teksturiranje modela. Njegovi napredni alati za maskiranje i proceduralno 

teksturiranje omogućuju izradu tekstura koje je puno teže postići u izvornim 2D programima poput 

Photoshopa. Jedna od mogućnosti je bojanje mapa u 2D prikazu, kao i izravno na 3D modelu 

unutar radnog prostora, što znači da se promjene mogu vidjeti u stvarnom vremenu. 

Substance Painter prikazuje i izvozi sve teksture u PBR ( eng. Physically Based Rendering) 

formatu, tako da će se uvesti izravno u mehanizam igre s potpuno istim rezultatom. [30] 

11.1. Korisničko sučelje 

Sučelje programa Substance Painter izgleda slično sučeljima drugih 3D programa poput 

Photoshopa. Na vrhu se nalazi standardna alatna traka gdje se nalaze padajući izbornici kao što je 

Datoteka i Uređivanje. 

 

Slika 11.1 Korisničko sučelje programa Substance Painter [30] 

 Na donjoj alatnoj traci nalaze se brojni alati kista za bojanje, gumice za uklanjanje 

pogrešaka ili uklanjanja dijelova koje ne želimo i velik niz alata za maskiranje. Sa lijeve strane 

ispod nalaze se razne druge postavke koje kontroliraju veličinu teksture i omogućuju dodavanje 

dodatnih osnovnih mapa na kojima se može slikati. Na dnu sučelja nalazi se polica koja sadrži 

velik izbor kistova, alfa i drugih mapa kojima se može slikati i maskirati.  
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U tom dijelu su i unaprijed postavljeni materijali i teksture koje se mogu koristiti na modelima 

i uređivati prema potrebi. U gornjem desnom dijelu nalazi se Urednik slojeva, a unutar njega nalazi 

se padajući izbornik koji omogućuje odabir pojedinačnih atributa sloja. U 3D PBR teksturama 

postoji nekoliko vrsta mapa i u ovom dijelu korisničkog sučelja je omogućeno izravno slikanje na 

pojedinačnim mapama. U središtu se nalaze prozori za 2D i 3D prikaz. 2D prikaz prikazuje 

teksturu onako kako se pojavljuje nakon izvoza, a 3D prozor prikazuje model kako će izgledati 

nakon izvoza.  

Jedna od najkorisnijih i najsnažnijih značajki ovog programa je alat za bake-anje. On 

omogućuje uzimanje low poly modela (modela s niskom rezolucijom mreže) kao predložak i 

korištenje drugog high poly modela (modela s viskom rezolucijom mreže) gdje se nakon što se 

uzmu svi detalji iz high poly modela detalji mogu bake-ati na low poly model i tim procesom će 

program  „ispeći“ Detaljnu mapu . [30] 

Završetkom teksturiranja sve mape koje su izrađene u programu mogu se izvesti u obliku 

slikovnih tekstura za korištenje u drugim programima. 

 

Slika 11.2 Izgled prozora za izvoz tekstura 
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12. Renderiranje i osvjetljenje 

Renderiranje je završna faza u procesu proizvodnje 3D računalne grafike. Iako širi kontekst 

renderiranja započinje sjenčanjem i teksturiranjem modela i osvjetljavanjem scene, postupak 

renderiranja završava kada se površine, materijali, svjetla i pokreti obrade u konačnu sliku ili slijed 

slika. Izrada renderiranih slika uvijek uključuje donošenje izbora koji utječu na kvalitetu 

(uklanjanje neravnina i uzorkovanje) slika, brzinu prikazivanja slika ili oboje. [31] 

Osim osnovnih rendera koje Maya nudi, kao što je Maya Software, možemo koristiti i 

priključke, te time koristiti Mental Ray render.  

12.1. Maya Software 

Funkcija za renderiranje Maya Software može kreirati slike visoke kvalitete sa osvjetljenjem, 

sjenama, teksturama i zamućivanjem pokreta. Za dodatne realnosti ponekad je potrebna refleksija 

(odbijanje svijetlosti) i refrakcija (prelamanje svijetlosti), što se može postići uključivanjem opcije 

Raytracing za praćenje zraka i podešavanjem funkcija za renderiranje Maya software. Praćenje 

zraka se također može koristiti za kreiranje preciznijih sjena objekata, koje izgledaju realnije. 

Praćenje zraka zahtijeva dodatne proračune, pa se takve slike duže renderiraju. [32] 

12.2. Mental Ray 

Mental Ray funkcija za renderiranje je po funkcionalnosti slična Maya Software renderu, no 

posjeduje napredne mogućnosti kao što su kaustika i globalno osvjetljenje koje mogu simulirati 

realističnije efekte svjetla. Osim toga, Mental Ray nudi i neke napredne načine osvjetljavanja scene 

kao što je Maya Sun and Sky opcija i Image Based Lighting. Maya Sun and Sky generira fizičko 

sunce i nebo unutar scene koje simulira stvaran odnos neba i sunca. Mental ray je integriran kao 

dodatak u velik broj vodećih 3D softvera od kojih je jedan i Maya. Ipak, Mental Ray se ne može 

koristiti za renderiranje Paint efekata sve dok nisu pretvoreni u NURBS ili poligonalnu geometriju. 

[32] 

12.3. Osvjetljenje 

Osvjetljenje je ključni element scene. Bez obzira da li je riječ o foto realističnom ili stilskom 

osvjetljenju, ono kontrolira izgled, atmosferu i vidljivost u sceni. Osvjetljenje u programu Maya 

ima mnogo sličnosti sa osvjetljenjem za filmove. Maya nudi šest vrsta rasvjete koje određuju razne 
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uvjete osvjetljenja. Isto tako, sve vrste svjetla mogu se koristiti kod Maya Software-a i Mental 

Ray-a. [32] 

Vrste svjetla su:  

− Ambient Light - proizvodi ravnomjernu, neusmjerenu svjetlost u cijeloj sceni. Svjetlo 

koje nema očigledan izvor, svjetlo koje se od svog izvora odbilo od nekoliko površina.  

− Area Light - osvijetljeni paneli i fluorescentno osvjetljenje. Pravokutni odrazi svjetla 

na zidovima.  

− Directional Light - paralelne zrake svjetla koje ravnomjerno osvjetljavaju scenu iz 

jednog određenog pravca. Sunčeva i mjesečeva svjetlost.  

− Point Light - zrači svjetlost iz svog centra u svim pravcima. Što je objekt dalje, manje 

će biti osvijetljen. Sijalice, LED diode, baklje.  

− Spot Light - osvjetljava prostor unutar definiranog konusnog područja. Baterijske i 

ulične lampe, farovi, reflektori.  

Volume Light -osvjetljava područje unutar definirane zapremnine. Područja oko slabih 

izvora svjetlosti kao što su baklje i vatre. Zrake svjetlosti koje prolaze kroz neki prostor. 

[32] 
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13. Praktični dio 

Proces izrade virtualnog lika ili modela započeo sam prikupljanjem smjernica i izradom skica 

i konceptne slike, tj. shematskog plana. Izrada ovog praktičnog rada bazira se na konceptnoj slici 

3D modela koja će se unutar programa Maya koristiti kao referentna slika. Sam tijek izrade modela 

bazira se najviše na poligonalnoj tehnici modeliranja iz primarnih oblika budući da se radi o 

modelu robota koji ima mehaničke dijelove tijela. Izrada modela podijeljena je na sekcije modela, 

počevši od izrade kuka, na koji sam nadovezao nogu, zatim je izrađeni dio trupa te okvir oko vrata. 

Nastavno tome krenuo sam sa izradom vrata i glave te se povremeno prebacivao na ostale izrađene 

dijelove radi dodatnog namještanja i dodavanja detalja i geometrije. Zatim sam izradio ruku i 

svjetlosne mačeve, te sve iste dijelove duplicirao i prebacio na drugu stranu. Završetkom 

modeliranja krenuo sam sa izradom UV mapa te dodavanjem materijala. Ovisno o izgledu dijelova 

modela koristio sam se različitim metodama mapiranja UV-a. Svaka sekcija modela sadrži 

nekoliko različitih materijala zbog velikog broja dijelova iz kojih je model izrađen, te radi lakšeg 

stvaranja UV mapa kako ne bi bile prenatrpane. Za izradu tekstura koristio sam dodavanje 

osnovnih boja unutar atributa materijala, proceduralne teksture unutar Maye (Substance 

materijale), Photoshop, a najveći dio tekstura izradio sam u programu Substance Painter. Kada je 

izrada cijelog modela bila gotova radi potrebe prezentiranja rada i prikaza slika gotovog modela 

kao i kasnije produkcije model sam namjestio u željenu pozu i renderirao nekoliko slika.  

13.1. Modeliranje 

Kako sam koristio konceptnu sliku za izradu modela koja nije otkrivala previše detalja modela, 

već je bila više kao smjernica za namještanje dijelova i njihovu pravilnu proporciju i izgled,  za 

pomoć pri izradi kreirao sam bazu sa snimkama zaslona prikupljenih iz filma.  

 

Slika 13.1 Dio snimki zaslona iz baze 
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13.1.1. Izrada referentne slike 

Referentne slike izradio sam pomoću izbornika Create>Free Image Plane te ih namjestio na 

željenu poziciju unutar scene.  

 

Slika 13.2 Izgled scene sa namještenim referencama 

13.1.2. Modeliranje poligonima 

Prilikom izrade gotovo svih dijelova modela modeliranje sam započeo korištenjem primarnih 

oblika poligona, te namještanjem broja podjela oblika i izgleda dodavajući geometriju. 

Namještanjem vrhova, rubova i lica sam izradio osnovni oblik nekog dijela modela i dodatnom 

manipulacijom i korištenjem alata izradio sam željene oblike. Takav tijek rada koristio sam za 

izradu svih elemenata koji su se tom metodom mogli izraditi. 

Izrada mehaničkog dijela kuka i dijela koji će se povezati sa trupom bila je prva faza kod 

modeliranja poligonima. Nakon izrade tog dijela krenuo sam sa modeliranjem noge i namjestio ju 

u prostoru gdje će se nadovezivati s postojećom geometrijom. 

 

Slika 13.3 Tijek izrade noge i kuka 
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Dio trupa sastoji se od staklenog dijela, rebra, organa i postolja vrata. Na postolju vrata bilo je 

potrebno izraditi otvor za cijevi, a sa zadnje strane dio koji predstavlja kralježnicu te dodatnu 

geometriju u prednjem dijelu. Rebra su povezana sa držačem koji je spojen na štitnik na trupu.  

 

Slika 13.4 Tijek izrade trupa 1. dio 

 

Slika 13.5 Tijek izrade trupa 2. dio 

Glava se sastoji od više dijelova od kojih je prvo izrađena maska, zatim nosač vrata te ostatak 

glave u koji spadaju uha, oči i tkivo oko očiju. U kasnijem procesu izrade spojena je na nosač i 

cijevi koje povezuju glavu sa trupom kroz okvir iznad postolja vrata. 
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Slika 13.6 Tijek izrade maske i osnovnog oblika glave 

Za dodatna namještanja pojedinih dijelova koristio sam deformer Latice i nelinearne deformere 

Bend i Twist koji se nalaze unutar modula Animacija i izbornika Create Deformers. Za prekid 

veze namještene geometrije i deformera potrebno je unutar izbornika Uredi obrisati povijest 

geometriji. 
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Slika 13.7 Tijek izrade oka, tkiva, uha i dodatnih dijelova glave 

 Završetkom izrade glave krenuo sam sa izradom štitnika trupa, izradom dodatnih dijelova 

modela i ruke.  Budući da dizajn robota ima dvije ruke sa svake strane spojene u jednu, a izradu 

sam započeo kreiranjem podlaktice te sam u kasnijem tijeku rada jednake dijelove ruke duplicirao 

za izradu i namještanje druge ruke.  
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Slika 13.8 Tijek rada izrade štitnika trupa i ostalih dijelova 

 

Slika 13.9 Tijek rada izrade ruke 
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Slika 13.10 Tijek rada izrade šake i zglobova ramena 

 

Slika 13.11 Tijek rada izrade svjetlosnih mačeva 

Naknadnim dodavanjem geometrije izradio sam sve ostale dijelove i detalje modela. Pritom 

sam se koristio svim navedenim i opisanim alatima iz izbornika Mesh i Edit Mesh koji su 

objašnjeni u teorijskom dijelu rada. Od primarnih poligonalnih oblika koristio sam kuglu, kocku, 

cilindar, plohu, piramidu i cijev. 

Ostali dijelovi kreirani su NURBS tehnikom modeliranja i kasnije su konvertirani u poligone. 
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13.1.3. NURBS modeliranje 

Prilikom izrade pojedinih dijelova modela koristio sam NURBS tehniku modeliranja. Ova 

tehnika modeliranja korištena je za izradu okvira vrata, cijevi u dijelu vrata, dijela štita na leđima 

i okvira štita, prednjih dijelova na površini stakla trupa te jednog dijela glave. 

Kreiranjem primarnog oblika kruga i namještanjem CV-a u prostoru te alatom Planar izradio 

sam postolje okvira. Izrađenu krivulju kruga duplicirao sam na željena mjesta za izradu okvira te 

sam koristio alat Loft i za izlaznu geometriju sam odabrao poligone. Zatim sam izradio tri kruga i 

koristio projiciranje krivulja na površini postolja okvira za izradu rupa za cijevi. Unutar izbornika 

Modify>Convert>NURBS to Polygons postolje okvira sam pretvorio u poligone i izradu okvira 

završio poligonalnom tehnikom modeliranja. 

 

Slika 13.12 Tijek izrade okvira vrata 
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Slika 13.13 Tijek rada izrade cijevi 

Sve cijevi izrađene su iz krugova krivulje ili poligonalnog oblika te korištenjem alata Extrude 

izvučene su po putanji krivulje namještene u prostoru, te radi potrebe pravilnog izgleda CV točke 

krivulje stavljene su na odgovarajuću poziciju. Prilikom izvlačenja krivulje po krivulji za izlaznu 

geometriju odabrani su poligoni. 
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Slika 13.14 Tijek rada izrade NURBS dijelova 

Štit na leđima izrađen je pomoću tri krivulje i korištenjem alata Loft za stvaranje površine 

između krivulja. Okvir štita izrađen je alatom Extrude izvlačenjem površine iz krivulje po putanji 

druge krivulje. Dio glave u obliku slova L izrađen je na isti način kao okvir štita s time da je na 

krajeve spojena dodatna geometrija izrađena iz primarnog oblika kugle. 

Po završetku modeliranja i izrade svih dijelova te dodavanja detalja krenuo sam sa drugom 

fazom, a to je dodavanje materijala. 
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13.2. Dodavanje materijala 

Postoje dva načina izrade materijala unutar programa Maya i tri načina dodavanja materijala 

na modele. Prvi način izrade ili dodavanja materijala je selektiranjem željene geometrije te 

držanjem desne tipke miša i odabirom Assign New Material ili odabirom već postojećeg 

materijala. Kod drugog načina potrebno je unutar prozora Hypershade izraditi materijal ili odabrati 

postojeći unutar kartice Materials, kada imamo željeni materijal potrebno je selektirati geometriju 

i držanjem desne tipke miša na materijalu odabrati Assign Material To Selection. Treći način 

dodavanja materijala na modele je povlačenje materijala na geometriju držeći srednju tipku miša. 

 

Slika 13.15 Dodavanje materijala na model korištenjem različitih načina 

U ovoj fazi započinje teksturiranje modela. Kod izrade modela za praktični dio rada izradio 

sam 39 materijala. Razlog većem broju materijala je raspodjela modela na sekcije i velik broj 

odvojenih dijelova kojim je trebalo izraditi UV mape. Kako ne bi izgubio na kvaliteti tekstura  

materijali su raspoređeni u materijale za mačeve, glavu, nogu, ruku, vrat i tijelo. Svaka sekcija 

modela ima i različite vrste materijala sa različitim teksturama. Kako većina izrađenog modela 

predstavlja metal koristio sam Blinn materijale sa različitim postavkama atributa sjaja i refleksije. 

Za svjetlosne mačeve koristio sam Blin materijale za oštrice, Mental Ray materijal 

mi_car_paint_phen_x za metalne dijelove, Phong za crne dijelove, Lambert za mat gumene 

dijelove i mi_metallic_paint_x za bakrene dijelove. Materijal Anisotropic sam koristio za oči radi 

mogućnosti postavljanja velike refleksije i sjaja. Za dio dijelova glave i tijela koristio sam 

mi_metallic_paint_x, Anisotropic i PhongE.  
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13.3. Izrada UV mapa 

Izradu UV mapa započeo sam prema sekcijama modela, a prva je bila noga. Prilikom mapiranja 

modela uglavnom sam koristio cilindrično mapiranje jer je većina geometrije bila izduženog 

oblika. Sve ravne površine ili one ravnije mapirao sam planarno ili bazirano na položaju kamere 

prema geometriji. Kompleksniju geometriju mapirao sam kombinacijom  svih metoda mapiranja. 

Kako se prilikom mapiranja dosta UV točka preklapalo dodatno namještanje unutar Urednika UV 

tekstura je bilo potrebno.  

UV točke površine na kojoj se želi koristiti uvezena slikovna tekstura moraju biti ispravno 

postavljene. Prilikom mapiranja koristio sam teksturu s kvadratićima i izradio sve UV mape  

raspoređene po materijala. 

 

Slika 13.16 UV mapiranje pomoću teksture s kvadratićima 

Kako postoji više UV mapa potrebno je sve UV točke rasporediti na odgovarajuću veličinu 

unutar mape kako bi prilikom izrade teksturnih mapa tekstura odgovarala veličinom na svim 

dijelovima. Prilikom izrade UV mapa uz namještanje, skaliranje i rotiranje pozicije točaka koristio 

sam alate Relax za automatsko raspetljavanje i ujednačavanje razmaka točaka i Unfold za 

odmotavanje kako bi izbjegao preklapanje točaka. Neke dijelove bilo je potrebno razdvojiti ili 

spojiti po odabranim rubovima kao i rotirati, izokrenuti ili poravnati u određenom smjeru.  
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Slika 13.17 Izgled UV mape selektiranih dijelova  

Završetkom izrade svih UV mapa koje je potrebno teksturirati krenuo sam sa izvozom 

geometrije po sekcijama modela i njihovim uvozom u program Substance Painer radi teksturiranja. 

13.4. Izrada tekstura u Substance painteru 

Unutar programa Substane Painter nakon uvoza modela krenuo sam sa izradom tekstura. Kako 

je svaki materijal imao svoju teksturnu mapu, unutar popisa teksturnih setova bilo je potrebno 

svaki set oslikati posebno.  

 

Slika 13.18 Izgled teksturirane glave unutar progama 
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Za teksturiranje koristio sam Smart materijale kojima je bila potrebna dodatna prilagodba radi 

zahtjeva rada. Korištenje tih materijala odlična je podloga za početak teksturiranja. Materijale sam 

koristio na dijelovima koji su zahtijevali izradu zasebnih slojeva i nisu dio mape Smart materijala.  

 

 Slika 13.19 Teksturne mape glave 
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13.5. Izrada teksura u Mayi 

Unutar Maye sjenčanje za mačeve izradio sam namještanjem osnovne boje unutar atributa 

materijala te sam iste primijenio na licima mačeva. 

 

 Slika 13.20 Izgled mačeva sa povezanim materijalima 

Za dio glave ispod maske u obliku cijevi koristio sam proceduralno teksturiranje gdje sam u 

prozoru Hypershade-a unutar kartice Create izradio 2D teksturu Substance. Za nju sam odabrao  

datoteku Aircraft_Metal.sbsar i stvorio mrežu sjenčanja gdje se unutar Urednika atributa mogu 

namjestiti unaprijed definirani parametri. 

 

 Slika 13.21 Izrada Substance teksture 
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13.6. Izrada teksture u Photoshopu 

Teksturu oka izradio sam izvozom snimke UV-a u Photoshop te na temelju izgleda UV mreže 

izradio 2D slike koje sam koristio kao površinsku teksturu i teksturu izbočine unutar atributa boje 

i atributa Bump  Mapping. 

. 

 Slika 13.22 Izgled oka teksturiranog u Photoshopu 

13.7. Poziranje modela 

Završetkom teksturiranja modela namješten je u T pozu i spreman je za daljnju pripremu izrade 

kostura te za kasnije korištenje u produkciji animiranih filmova ili video igara. Da bi nekom iza 

procesa modeliranja bilo lakše korištenje modela poželjno je sve dijelove modela imenovati i 

grupirati u jednu grupu.  

 

 Slika 13.23 Outliner 
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Nakon dodavanja imena dijelovima modela i namještanja točka okretišta (eng. pivot point) 

neke dijelove modela sam grupirao, a neke povezao opcijom Parent koja omogućuje hijerarhijsko 

povezivanje dijelova pri čemu su odabrani objekti podređeni  zadnje odabranom. Pregled svih 

dijelova scene kao i grupa te međusobnih veza između objekta moguće je unutar prozora Outliner 

koji se nalazi u izborniku Prozor. Takav način povezivanja omogućio mi je namještanje modela u 

prostoru i pripremu za izradu završne kompozicije modela za prezentiranje. 

 

 Slika 13.24 Izgled prednjeg dijela modela u T pozi 

 

 Slika 13.25 Izgled svjetlosnih mačeva 
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 Slika 13.26 Izgled zadnjeg dijela modela u T pozi 

 

 Slika 13.27 Izgled gornjeg dijela tijela modela 
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13.8. Renderiranje modela 

Renderiranje je završni proces modeliranja i za potrebe rada model sam pozirao u željenu pozu. 

Unutar scene kreirao sam tri svjetla, dva Directional Light u prednjem dijelu za dobivanje 

pravilnog osvjetljenja, te jedno Area Light u pozadini kako bi naglasio obris modela. Unutar 

postavki rendera koristio sam priključak Mental Ray i namjestio parametre za renderiranje slike . 

U kartici Indirect Lighting uključio sam opciju Image Based Lighting koja se temelji na simulaciji 

svjetlosti iz slike koja se emitira iz kugle stvorene u prostoru. 

 

 

 Slika 13.28 Renderirana slika namještenog modela s prednje strane 



65 

 

 

 Slika 13.29 Renderirana slika namještenog modela s bočne lijeve strane 
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 Slika 13.30 Renderirana slika namještenog modela s bočne desne strane 
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14. Zaključak 

Kreiranje virtualnih likova se temelji na izradi 3D modela unutar 3D prostora. Ako se radi o 

konceptnoj izradi važna je priprema i prikupljanje potrebnih informacija koje će pomoći prilikom 

izrade likova. Ovisno gdje i za što će se model koristiti odabiru se metode modeliranja. Model 

izrađen u praktičnom dijelu rada namijenjen je za korištenje u filmskoj industriji i izradi animiranih 

filmova te kasnijoj primjeni u industriji video igara.  

Metode koje su korištene prilikom modeliranja odabrane su s obzirom na namjenu modela. 

Kako je prilikom korištenja modela unutar nabrojanih industrija potrebna izrada modela metodom 

poligonalnog modeliranja, najveći dio modela je izrađen iz poligona unutar programa Maya. Neke 

dijelove modela bilo je lakše izraditi NURBS metodom modeliranja, ali je za vrijeme izrade 

izlazna geometrija odabrana kao poligonalna ili je po završetku modeliranja NURBS-ima sva 

dobivena geometrija bila konvertirana u poligone. Poligonalno modeliranje prikladnije je za izradu 

virtualnih likova iz razloga jer je po završetku izrade modela isti potrebno i teksturirati.  

Dodavanjem materijala na površinu započinje proces teksturiranja modela. Kako postoje dva 

glavna čimbenika koji određuju izgled površine, a to su svjetlost i od čega je materijal napravljen, 

potrebno je pravilno odabrati materijale koji će se primijeniti na površini modela. Budući da je 

modelu robota kojeg sam izradio u praktičnom dijelu rada glavni sastavni materijal metal koristio 

sam materijale koji unutar opcija atributa imaju mogućnost namještanja sjaja i refleksije. 

 Prije procesa teksturiranja kako bi se teksturne mape pravilno prikazale na površini modelu je 

potrebno izraditi UV mape. S obzirom na izgled dijelova za UV mapiranje koriste se najprikladnije 

metode mapiranja. Prilikom korištenja tekstura koje koriste slikovni prikaz važno je sve UV mape 

kreirati unutar definiranog UV prostora. 

Za izradu navedenih mapa korištenje specijaliziranih programa je najprikladnije jer se 

teksturne mape mogu izvesti i primjenjivati u različitim programima. Pomoću teksturnih mapa 

modelu se daje smisao, a upotrebom mapa za izmjenu geometrije omogućeno je smanjivanje broja 

poligona i optimizacija modela. 

Kako bi se naknadno korištenje modela u različitim industrijama olakšalo model je poželjno 

namjestiti u T pozu, grupirati ga cijelog i imenovati sve dijelove i takav model je spreman za izradu 

kostura i animaciju te upotrebu u navedenim industrijama. 

 

 

U Varaždinu, ___________________              ______________________________ 

Potpis studenta 
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